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For information on how to use Help, press F1 or select Using Help from the Help menu.



Overview

"Pronto" means "soon" in Spanish. Soon you are going to have an important appointment 
you will not want to miss.    UZPronto helps you to keep track of your appointments.    It is a 
simple, yet powerful appointment calendar designed specifically for laptop computers, 
although it will also run well on desktop systems.

Here are some of the powerful features of UZPronto:

It lets you easily schedule appointments, tasks and reminders, and will notify you in advance
when one comes due.    It is designed to continuously run while you are in Windows,    either 
iconified or as an open window in the background.    We recommend that you start it from 
the Startup Program Group, as detailed in the Installation instructions.

It includes a set of appointment calendars which you can include in your own customized 
appointment book,    such as U.S. and other countries' holidays (for travelling), professional-
related,    such as computer trade show dates, etc.    Customization is a matter of a few 
mouse button clicks or keystrokes.    For example, if you are doing business in or going on a 
trip to Canada, either open the calendar listing Canadian holidays, or include it in your own 
personal book.

You can schedule individual appointments,    or create recurring events, like birthdays, 
anniversaries, monthly reminders, weekly meetings, etc.    Duration and advance notice are 
fully configurable.    Rescheduling an appointment is as easy as a double click.    View your 
appointments on a daily,    weekly or monthly basis.

UZPronto also has a convenient cut-and-paste feature, which lets you cut (or copy) 
appointments from text in another window (for example e-mail,    or from a WWW browser) 
onto the Windows Clipboard, then paste them into your appointment books with a few 
mouse clicks.

Some of the behind-the-scenes "invisible" features are:

It works correctly with modern laptops' Suspend/Resume mode.    When you press the 
Resume button,    UZPronto will automatically position itself on today's date.

The "autosave" feature saves your active calendar to disk every 5 minutes,    thus reducing 
the need for those pesky "Save now?" messages upon exiting Windows.    When saving any 
file,    it will create a backup of the existing file first,    so you can always recover from 
mistakes.

UZPronto's color scheme has been designed for monochrome laptop displays as well as color
displays.    Its space-saving user interface works well on small laptop screens and large SVGA
desktop screens.    Fonts used in views are configurable.

Finally,    UZPronto is designed to be simple and unobtrusive.    It is small, uses little disk 
space and computing power.

The Getting Started section gives you a 5 minute introduction to UZPronto.    Check it out!



Installation

Windows 3.x

Since there are many ways to get UZPronto,    there are as many ways to install it,    and one 
simple alternative is to follow these instructions:

1) Copy the files from the distribution medium onto your computer.    This depends on how 
you got your copy of the product,    and how familiar you are with DOS or Windows:

a) first make a separate directory (either by using mkdir from the DOS prompt, or "File" 
"Create Directory" from the File Manager),    for example C:\UZPRONTO;

NOTE: It is highly recommended to install into a newly created directory, so that you can 
easily upgrade or uninstall later.

NOTE: If you have a previous registered version of UZPronto, we still recommend installing 
into a new directory.    For example, if you named the old directory UZPRONTO, you should 
rename it to UZPRONTO.OLD.

b) then copy the files from your distribution medium:
- if you got UZPronto in a downloaded archive file (PKUNZIP, LHARC, ZOO, ...), you need to 
extract it with the appropriate extraction program;

- if you have it on a diskette or CD-ROM,    just copy them into that directory    (for example: 
in DOS type 
XCOPY /S A:\UZPRONTO\*.* C:\UZPRONTO
or in the File Manager use the "File" "Copy" command).

2) Run the installation batch file INSTALL.BAT (either from the DOS prompt,    or by double-
clicking on it in the File Manager).    This script makes sure that extracted files are in their 
correct subdirectory with correct permissions,    and asks you to copy files into your system 
directories.    Your system area is not modified without your permission!

NOTE: if you are upgrading from a previous registered version of UZPronto, now copy the old
license file (UZPRONTO.OLD\UZPRONTO.LIC ) and configuration file    (UZPRONTO.OLD\
UZPRONTO.INI) to the freshly installed directory.    If you saved your calendar files in    
UZPRONTO.OLD\DATA, then copy them to the DATA subdirectory of the freshly installed 
directory.    This will spare you the time (and cost!) of reregistering the software and keeps 
your old calendars. When you are sure that the new revision is working well, you can remove
the old version by deleting the directory UZPRONTO.OLD.

3) If you have not done so already, create a new program item in a program group, so that 
you can run UZPronto by double-clicking on its icon, like any of the other applications. You 
can do this in the Program Manager either by

a) dragging the "UZPronto" executable file from the File Manager into the program group 
(consult your Windows manual);    or by

a) restoring the    program group (for example, by double-clicking on its icon); and
b) choosing the "File" and "New..." menu entry of the Program Manager. Choose "Program 
item" and hit "OK".    Set its "Description" to "UZPronto", its "Command Line" to "uzpronto" 
and its working directory to the directory where you installed the UZPronto files. When you 
are done, the "UZPronto" icon should be in the currently selected program group.



4) double-click on the UZPronto icon (to verify that it works).    UZPronto is started when its 
main window shows on the desktop.    Check for the version number with the "Help" "About" 
menu entry.

5) you can also copy the UZPronto icon to the Startup group, so that it is automatically 
invoked when Windows starts up.    The most convenient way is to start it iconified (set "Run 
Minimized" in the "File" "Properties" command in the Program Manager menu).

To uninstall UZPronto in the event you are not going to use it, simply reverse the steps 
above, that is:
1) stop running the program.
2) remove the program item from any program group that you added it to.
3) run the uninstall batch script UNINSTAL.BAT from the DOS prompt.
4) remove the files from the directory where you copied them to.

Windows 95

Since there are many ways to get UZPronto,    there are as many ways to install it,    
and one simple alternative is to follow these instructions:

1) Copy the files from the distribution medium onto your computer.    This depends on how 
you got your copy of the product,    and how familiar you are with DOS or Windows:

a) first make a separate folder on your hard-disk (either by using MKDIR from the DOS 
prompt, or "File" "New" "Folder" from the "My Computer" utility or the Windows Explorer),    
for example C:\UZPRONTO ;

NOTE: It is highly recommended to install into a newly created folder, so that you can easily 
upgrade or uninstall later.

NOTE: If you have a previous registered version of UZPronto, we still recommend installing 
into a new folder. For example, if you named the old folder UZPRONTO, you should rename it
to UZPRONTO.OLD.

b) then copy the files from your distribution medium:
- if you got UZPronto in a downloaded archive file (PKUNZIP, LHARC, ZOO, ...), you need to 
extract it with the appropriate extraction program;

- if you have it on a diskette or CD-ROM,    just copy them into that folder    (for example: in 
DOS type 
XCOPY /S A:\UZPRONTO\*.* C:\UZPRONTO
or in the Explorer open the floppy disk or CD-ROM, select all the files, then use the "Edit" 
"Copy" command to copy them, open the folder that you created in step a), then use "Edit" 
"Paste").

2) Run the installation batch file INSTALL.BAT (either from the DOS prompt,    or by double-
clicking on it in the Explorer).    This script makes sure that extracted files are in their correct 
subfolder with correct permissions,    and asks you to copy files into your system folders.    
Your system area is not modified without your permission!

NOTE: if you are upgrading from a previous registered version of UZPronto, now copy the old



license file (UZPRONTO.OLD\UZPRONTO.LIC ) and configuration file    (UZPRONTO.OLD\
UZPRONTO.INI) to the freshly installed folder.    If you saved your calendar files in    
UZPRONTO.OLD\DATA, then copy them to the DATA subdirectory of the freshly installed 
directory.    This will spare you the time (and cost!) of reregistering the software and keeps 
your old calendars. When you are sure that the new revision is working well, you can remove
the old version by deleting the folder    UZPRONTO.OLD.

3) if you have not done so already, create a new program shortcut.    You can do this in the 
Explorer by dragging the "UZPronto" executable file from the Explorer onto the desktop.

4) double-click on the UZPronto shortcut.    UZPronto is started when its main window shows 
on the desktop.    Check for the version number with the "Help" "About" menu entry.

Once you are sure that UZPronto works, you can put it in the "Startup" folder, so that 
it automatically starts running when Windows begins. Do this by moving or copying the 
UZPronto shortcut into the \Windows\Startup folder.

To uninstall UZPronto in the event you are not going to use it, simply reverse the 
steps above, that is:

1) stop running the program;
2) remove the shortcut from any folders that you added it to;
3) remove the files from the folder where you copied them to.



Getting Started

Once you have installed UZPronto and run it for the first time,    it will display a demo 
calendar that shows sample appointments.    Use this calendar to follow along these 
instructions: you can flip pages in the calendar with the View|Next and View|Previous menu 
commands, or the PgUp and PgDn keys on your keyboard.    You can display appointments a 
day, week or month at a time by using the View|Day,    View|Week or View|Month menu 
commands.    The Toolbar lets you accomplish the most common commands with a single 
mouse click.    Try it out now.

When you are ready to create your own calendar, close the demo calendar with the File|
Close command.    Then you can create a new calendar with the File|New command.    
UZPronto will ask you to give the calendar a title,    so that you can distinguish it from all the 
other calendars on the system.

Now you are ready to add appointments:    double click on the day on which    you want to 
add it,    which brings up the Appointment Editor.    There you can fill in the appointment.    Try
a test appointment for starters,    you'll be able to delete it later.    Once you have added it,    
you need to save the calendar with the File|Save command.    Give it a descriptive filename 
(upto 8 characters).    From now on,    when you start UZPronto, it will use that calendar.    Try 
it out by exiting the program with the File|Exit command,    then run UZPronto again - your 
appointment will be there as expected!

Now try including one of the pre-defined calendars, by using the File|Include command.    
Select any of the calendars listed,    and you will have those events included in your own 
calendar.    Check it out,    by traversing the calendar in the Month View.    If you don't want 
that included calendar any more,    you can use the File|Exclude command. Try it now.



Licensing

SUMMARY
-------

Shareware, 30-day fully functional evaluation license.
Registration fee: $15 for individual license.
To register, print and return the file register.txt .
Compuserve: GO SWREG 5328, $20 + S/H charges for floppy.

DETAILS
-------

UZPronto    is copyrighted material by UZful Software, Inc., and is
distributed as shareware.    Shareware    distribution    of    a    program gives
users a chance to try    software    before buying it.    The copy of UZPronto
you have received is given an evaluation license for a certain number of
days (generally    30 days,    depending on the version).    You can check the
status of your license with the    "About" menu command.    For the duration
of the evaluation period,    the    program    is fully    functional.    When the
evaluation is over, it will give you a notice and no longer run!    If you
try a    Shareware program and want to continue using it, you are expected
to register.

Copyright    laws apply to both Shareware and    commercial software,
and    the    copyright    holder    retains    all    rights,    with a    few specific
exceptions as stated below. Shareware authors generally are accomplished
programmers,    just    like    commercial    authors,    and    the programs are of
comparable    quality    (in    both    cases,    there    are good programs and bad
ones!). The main difference is in the method of distribution.

Shareware    is a distribution method,    not a type of software. You
should find software that suits your needs and pocketbook,    whether it's
commercial or Shareware.    The    Shareware system makes fitting your needs
easier, because you can try before you buy.    And because the overhead is
low,    prices are low also.    Shareware has the ideal money-back guarantee
-- if you don't use the product, you don't pay for it.

DISCLAIMER - AGREEMENT
----------------------

Users of UZPronto must accept this disclaimer of warranty:
UZPronto    is    supplied    as    is.      UZful    Software,    Inc.    disclaims    all
warranties,    expressed or    implied,    including,    without limitation, the
warranties    of    merchantability    and of fitness    for any purpose.    UZful
Software Inc. assumes no liability for damages, direct or consequential,
which may result from the use of UZPronto.

UZPronto    is    a "shareware program"    and is provided at no charge
to the user for evaluation. Feel free to share it with your friends, but
do not give it away altered or as part of another system. UZful Software
grants the    right    to    copy    and    distribute    this    version of UZPronto,
provided    that all    files in the received package    (as shown in the file
packing.lst)    are    unmodified    and    distributed together,    either on the
same disk or in the same archive.



The recipient of this    copy shall not    use,    copy,    rent,    lease,
sell,    modify,    decompile, disassemble,    otherwise    reverse engineer, or
transfer the licensed program    except    as    provided    in    this agreement.
Any    such    unauthorized    use    shall result    in    immediate    and automatic
termination of this license.

U.S.    Government Information:    Use, duplication, or disclosure by
the U.S.    Government    of the computer software and documentation in this
package    shall    be    subject    to    the    restricted    rights    applicable    to
commercial    computer    software as set forth in subdivision (b)(3)(ii) of
the          Rights    in    Technical    Data    and    Computer    Software    clause    at
252.227-7013      (DFARS 52.227-7013).      The      Contractor/ manufacturer    is
UZful Software, Inc., PO Box 2089, Merrimack, NH 03054-2089, USA.

All rights not expressly granted here    are    reserved    to    UZful
Software, Inc.

REGISTRATION
------------

The essence of "user-supported"    software is to provide personal
computer users with    high quality    software at a    low cost,    and yet to
provide    incentive for programmers to continue to develop new products,
and to maintain and improve released products. If you find this program
useful and find that you are    using    UZPronto    and want to    continue to
use    UZPronto after the evaluation period, you must make a registration
payment    of    $15.00    to    UZful    Software, Inc.    The    $15.00    individual
registration fee will license one copy of this version of UZPronto    for
use on    one    computer.    You must register    UZPronto    for every computer
on which you want to run it.    Specifically, the    individual    license is
issued for a certain computer and the program will    not run on    another
computer    without    registering    it.

To register your copy of    UZPronto,    run the utility    "uzlicinf"
provided with this distribution at the    DOS prompt on the computer that
you    want to    run    UZPronto    on,    and    send    its    output along with the
registration payment to

UZful Software, Inc.
PO Box 2089
Merrimack, NH 03054-2089
------------------------

Please use the form in the file    register.txt    to register    this
program via    postal mail    and allow for (at least!)    1 week    of transit
and administrative    delay.    Don't    forget to indicate a    return    postal
address    or    e-mail    account where we can return your    license.    If you
live    outside    the United States,    payment must be made by a bank check
in U.S. $ drawn on a bank in the U.S.

If you are a    CompuServe user, you may register this program via
the Shareware Registration service    (GO    SWREG),    registration ID    5328
The library    file (GO WINSHARE) also contains the    registration    number
A    floppy    containing the current (or latest) version of the registered
program, as well as    evaluation    copies of our other products,    will be



mailed    to    you.    Although    not    critical,    please    first      e-mail    the
registration    form,    as it will give us some information on your laptop
model to serve you better.

Commercial users of    UZPronto    must    register and pay for their
copies of UZPronto within    30 days    of first    use    or their    license is
withdrawn.    Non-restrictive Site-License arrangements and custom orders
may be made by contacting UZful Software, Inc. directly.

DISTRIBUTORS
------------

Anyone distributing    UZPronto    for any kind of remuneration must
first contact    UZful Software    at the    address below for authorization.
This    authorization    will    be    automatically    granted    to    distributors
recognized by the    (ASP)    as    adhering to its guidelines    for shareware
distributors,    and    such    distributors    may    begin    offering      UZPronto
immediately    (however UZful Software must still    be advised so that the
distributor can be kept up-to-date with the latest version of UZPronto).

UZful Software, Inc.
PO Box 2089
Merrimack, NH 03054-2089
------------------------



Limitations

Since this is one of the initial releases of the product, there are some limitations and known 
problems:

1) you can only view one calendar at a time;
2) you cannot print the calendar (but you can save your calendar view into the clipboard 

with the "Print Screen" key on your keyboard, then print it);
3) the Edit Undo command is not implemented;
4) the Edit Copy and Edit Cut commands are not implemented;
5) an appointment can have at most 4 days (99 hours) advance notice;

We will be working on these. If you want to see other improvements, please let us know.



Technical Support

UZful Software provides on-line support to registered users via e-mail at uzful@mv.mv.com.   
Before you report a problem, please look at the list of frequently asked questions in 
FAQ.TXT . To report a problem, please include
- the version of UZPronto,
- the type of PC, and
- the symptoms of the problem (any special circumstances that make the problem appear? 
How often does it occur? Can you reproduce the problem?).    Please describe the details of 
the problem precisely.    The more info you provide, the quicker we can fix it.

If you have additional suggestions on how to make our products even more useful, please 
drop us a line.



File Menu

The File menu provides commands for manipulating calendar and files:
- creating new calendars,
- opening existing calendars,
- saving calendar files,
- printing calendars, and
- exiting the application.

New Create a new calendar.
Open Open an existing calendar.
Close Close the current calendar.
Save Save the current calendar if its contents have changed.
Save As Save the current calendar under a new name.

Include Include another calendar in this one.
Exclude Exclude an included calendar.
Import Import from a different file format into this calendar.
Export Export this calendar in TAB-separated ASCII format.

Print Print the current calendar.
Print Preview View a sample printout of the current calendar.
Print Setup Set printer characteristics.

Exit Exit the application.



Edit Menu

The Edit menu provides commands to undo edits, access the clipboard, and to delete text.

Undo Undo the previous operation.
Cut Delete the selected appointment and move it to the clipboard.
Copy Copy the selected appointment to the clipboard.
Paste Paste text from the clipboard to the current calendar into new appointment.
Clear All Delete all appointments in calendar view.
Delete Delete selected appointment.



Search Menu

The Search menu provides commands to find and replace text.

Find Find an appointment containing a pattern of text.
Replace Replace one pattern of text with another.
Next Find and/or replace the next occurrence of text pattern.



Settings Menu

The Settings menu provides commands to change settings.

Program Change program settings.
Calendar Change calendar settings.
Fonts Change the fonts used in the week and month views.



View Menu

The View menu provides commands to view appointments in different ways.

Previous Display previous page in currently active view.
Next Display next page in currently active view.
Today Display today's appointments in active view.

Day Display the current day's appointments.
Week Display the current week's appointments.
Month Display the current month's appointments.

Day Selector Popup the Day Selector tool.
Appointment Editor Popup the Appointment Editor tool.



Adding an appointment

To create a new appointment, you can use 3 quick methods:

1) in the Day View, simply type the summary of the appointment into the field at the desired
time and press the RETURN key.    This will quickly add an appointment with the default 
attributes (duration: 1hour, notice: 30 minutes, medium priority) at that time.

2) in any view, double click on the desired day, or select the View|Appointment Editor 
command from the main menu.    This will popup the Appointment Editor dialog, which lets 
you specify all the details of the new appointment.

3) if you have the text of the appointment in another window, for example in an e-mail 
message, just copy it onto the Clipboard (usually "Edit" "Copy", depending on what 
command the other application uses to copy text),    then select the Edit|Paste command 
from the UZPronto main menu.    The appointment is automatically added, and the 
Appointment Editor appears so that you can change it if you so desire.    Otherwise, just 
dismiss the Appointment Editor.



Changing an appointment

To change an appointment, simply double-click on the appointment, which will popup the 
Appointment Editor dialog.    It lets you quickly change any appointment attribute.    
Appointments from included calendars cannot be changed, and the "Change" button will be 
disabled.



Deleting an appointment

To delete an appointment, simply double-click on the appointment, which will popup the 
Appointment Editor dialog.    It lets you delete any appointment in the active calendar.    
Appointments from included calendars cannot be deleted,    and the "Delete" button will be 
disabled.



Searching for an appointment

To find an appointment, use the Search|Find command.    It finds the next appointment that 
contains the specified word.    The day of the appointment will be highlighted in the view.



Getting an appointment notice

When an appointment becomes due,    you will get an appointment notice.    This is a small 
dialog which displays the appointment due date (When) and the appointment text (What).   
You can complete the appointment by clicking the "Complete" button.

NOTE: that you cannot dismiss the dialog by pressing the "Enter" or "Return" key.    This is 
so you don't accidentally miss the notice while you are typing in some other window.

You can also postpone the notice by pressing the "Postpone" button. This will delay the 
notification for another 5 minutes.    If time is up,    you cannot delay it any longer (the anti-
procrastination feature ;!).



Exiting

To exit the application, choose File|Exit from the menu.    UZPronto will prompt you if the 
active calendar needs saving.



Drag/Drop from the File Manager (Unsupported)

A file can be opened into an editor in the application by dragging the file from the File 
Manager, and dropping it on UZPronto's main window.



Printing (Unsupported)

There are three commands on the File menu which support printing of calendars from the 
application.    File|Print Setup is used to select and configure a printer device.    File|Print 
Preview displays a special preview window which shows how the calendar will appear when 
printed.    File|Print causes the current calendar to be printed.



File New Command

The File|New command opens a new calendar, and makes it the active window. The 
application prompts you to give the calendar a title.



File Open Command

The File|Open command lets you open an existing UZPronto calendar.    The File Open dialog 
shows you the title of the calendar when you select it from the displayed list.    Once you 
click OK,    the appointments contained in the calendar are loaded into the currently 
displayed view.



File Close Command

File|Close closes the currently active calendar.    If it has been modified,    you will be 
prompted on whether you want to save it.



File Save Command

The File|Save command saves the calendar in the active window to disk. If the calendar is 
unnamed, the Save File As dialog box is displayed so you can name the file, and choose 
where it is to be saved.
UZPronto also automatically saves the calendar every 5 minutes, so you won't have to.



File Save As Command

The File|Save As command allows you to save a calendar under an new name, or in a new 
location on disk.    The command displays the Save File As dialog box.    You can enter the 
new file name, including the drive and directory.    If you choose an existing file name, you 
are asked if you want to overwrite the existing file. 

NOTE: a word about where to save your calendar files. By default, UZPronto saves new 
calendars in the DATA\ area where the program lives.    This is useful if you share your 
calendars among multiple people.    I save my calendars under my home directory, because 
this way I keep all my data together, and know it will be backed up along with the rest of my 
data.



File Include Command

The File|Include command allows you to include another UZPronto calendar in the currently 
active one.    This is an easy way of customizing your calendar, for example, if you live in 
Canada, you can include the calendar containing the Canadian holidays.    Or, if you are 
interested in the upcoming computer-related trade shows, you can include the calendar 
containing those.

UZPronto supplies a set of calendars containing
- country-specific holidays (for international business);
- country-specific festivities (for travel);
- professional events;
- hobbies.

Calendars are added and updated frequently and will be included in any future upgrades.

NOTE: A note about the calendars supplied with UZPronto:    we made an effort to ensure 
that the listed events in all predefined calendars are accurate.    Still, mistakes always 
happen,    and events are sometimes changed,    so if you find an incorrect one, please let us 
know.



File Exclude Command

The File|Exclude command allows you to exclude a previously included calendar from your 
appointment book.    This is the converse operation of the File|Include command.



File Import Command

The File|Import command allows you to import a calendar in a foreign format from another 
calendar application.    This is useful,    if you are using more than one appointment calendar 
(at work, for example),    to synchronize your calendars.    UZPronto currently allows you to 
import calendar appointments from

Borland Sidekick 1.0 exported task and event lists
Lotus Organizer .CSV format (with all fields mapped).

Duplicate appointments (ie. appointments which already exists in your calendar) will be 
ignored.



File Export Command

The File|Export command allows you to export the currently active calendar in TAB-
separated format.    This is useful if you want to include calendar appointments in other 
applications, such as spreadsheets, etc.



File Print Command (Unsupported)

The File|Print command prints the contents of the active window.    Use File|Print Preview to 
see how the calendar will be laid out on printed pages.    Use File|Print Setup to select a 
printer, and to set printer options.



File Print Preview Command (Unsupported)

File|Print Preview opens a special window that shows how the active calendar will appear 
when printed.    The preview window shows one or two pages of the active calendar as they 
would be laid out on printer pages.    Controls on the window allow you to page through the 
pages of the calendar.



File Print Setup Command

The File|Printer Setup command displays the Printer Setup dialog box which allows you to 
select and configure the printer to be used to print calendars in the application.



File Exit Command

The File|Exit command exits UZPronto.    If you've modified your appointment book without 
saving, you'll be prompted to save before exiting.



Edit Undo Command (Unsupported)

The Edit|Undo command restores the file in the current window to the way it was before your
most recent edit operation.    Undo inserts any characters you deleted, deletes any 
characters you inserted, replaces any characters you overwrote, and moves your cursor 
back to a prior position.



Edit Copy Command (Unsupported)

The Edit|Copy command leaves the selected appointment intact and places an exact copy of
it in the clipboard.    To paste the copied appointment into another calendar, choose Edit|
Paste.



Edit Cut Command (Unsupported)

The Edit|Cut command removes the selected appointment from your calendar and places 
the text in the clipboard.    Choose Edit|Paste to paste the cut appointment into another 
calendar. The text remains selected in the clipboard, and can be pasted multiple times. 



Edit Paste Command

The Edit|Paste command inserts the text currently selected in the clipboard into the calendar
as an appointment.    Date and time are automatically searched for in the appointment text, 
and the appointment is added at the appropriate time.    The Appointment Editor dialog is 
displayed, so you can easily change the newly added appointment.

UZPronto generally recognizes text of the following form as an appointment

<Date> <Time> <Text>

where <Date> is some way of expressing a date, <Time> is some way of expressing a time,
and <Text> is some reminder.    It will search the pasted text for this pattern, and create an 
appointment at the specified time containing the text    Here are examples of what is 
understood:

On March 20 at 10 am we will have a meeting to discuss these issues...

Let's meet tomorrow at 1:30pm in the Palmer Room to review....

At 5:30pm, call home.

Date: April 1
Time: 11:59pm
Deadline for Ziff-Davis shareware awards



Edit Clear All Command

The Edit|Clear All command deletes all appointments in the current view.    If you are in the 
day view,    the day's appointments will be deleted,    whereas if you are in the week view,    
the week's appointments are deleted,    and similarly for the month view.    Currently,    
recurring appointments are NOT deleted.    The deleted appointments can currently NOT be 
restored with    Edit|Undo.



Edit Delete Command (Unsupported)

The Edit|Delete command deletes the currently selected appointment from the calendar.    
The appointment is not placed in the clipboard.    Use the Edit|Undo command to restore the 
text.



Search Find Command

The Search|Find command searches the current calendar for the next appointment that 
contains a text pattern.    The command displays the Find dialog which controls the search 
process.    Options in the dialog determine whether only whole words are to be matched, and
whether the case of characters is significant.    As each match is found, it's day is highlighted
in the calendar.



Search Next Command

The Search|Next command repeats the last Find or Replace operation.



Search Replace Command (Unsupported)

The Search|Replace command searches the current calendar for a text pattern, and replaces
occurrences of the of the pattern with new text.    The command displays the Replace dialog 
which controls the search/replace process.    Options in the dialog determine whether only 
whole words are to be matched, and whether the case of characters is significant.    The 
dialog is also used to specify the pattern to search for, and the text to replace occurrences 
with.



View Previous Command

The View|Previous command displays the previous page in the calendar, which depending on
the currently active view is either the previous day, week or month.



View Next Command

The View|Next command displays the next page in the calendar, which depending on the 
currently active view is either the next day, week or month.



View Today Command

The View|Today command displays the page in the calendar containing today's 
appointments.



View Day Command

The View|Day command displays the currently selected day's appointments.    It also lets you
quickly add appointments by just typing the.summary in the appropriate time slot, and then 
pressing RETURN.    The appointment will be added with the default attributes (duration,    
advance notice time,    priority).

An appointment can have an indicator:    a green check mark if it is completed, and a red 
exclamation mark if it is of high priority.



View Week Command

The View|Week command displays the currently selected week's appointments.    Each day's 
appointments are shown in their own box.    The currently selected day is highlighted with a 
red frame.    You can double-click on any day to popup the Appointment Editor dialog.



View Month Command

The View|Month command displays the currently selected month's appointments.    Each 
day's appointments are shown in their own box.    The currently selected day is highlighted 
with a red frame.    You can double-click on any day to popup the Appointment Editor dialog.



View Day Selector Command

The View|Day Selector command pops up or dismisses the Day Selector tool.    This tool lets 
you quickly select any date to be displayed in any of the other views.    This is useful for 
selecting dates which are far from the currently selected date.    It is a button box,    with one 
button per day in the currently selected month.    When you click on one of those buttons,    
the other views will be set to the selected date.

You can traverse months with the "<<Previous" or "Next>>" buttons.    The "Today" 
button brings you back to today's date in the Day Selector (remember to press one of the 
buttons in the button box to select the date for the other views).

Pressing the "Done" button or the ESC key dismisses this popup.



View Appointment Editor

The View|Appointment Editor command pops up the Appointment Editor tool.    This tool lets 
you quickly manipulate appointments:

1) add a new appointment by filling in the appropriate information, then selecting the 
"Insert" button;

2) change an existing appointment, by choosing it from the displayed list, changing the 
desired field, then pressing the "Change" button;

3) delete an appointment, by choosing it from the list, then pressing the "Delete" button;
4) when you are done with this dialog, press the "Done" button;
5) create a recurring appointment by pressing the "Repeat>>" button.

You can set the following fields for an appointment:

Date and Time specify the scheduled time for the appointment.    For recurring 
appointments this means the scheduled time for the first event.

Duration determines how long the appointment lasts (in hours and minutes).
Priority assigns a priority to the appointment.    High priority appointments are 

notified with a popup and a beep,    medium priority appointments are notified
without a beep, and low appointments are not notified with a popup.    High 
priority is shown in the views with a red exclamation mark.

Notice specifies how far in advance of the appointment you want to be notified (in 
hours and minutes) of the pending appointment.

Summary sets the string to be displayed for the appointment.
Comment this contains any comments you may want to append to the appointment.    

This text is only shown in the Appointment Editor.
Status lets you keep track of the status of the appointment.    An appointment (or 

task) starts out being "Open".    In this state,    when the appointment 
becomes due, you will be notified (depending on the priority, as described 
above).    "Completed" appointments are indicated with a green checkmark, 
and you will not be notified when they are due.

Every this field is displayed after you click the "Repeat>>" button to let you 
schedule recurring events.    The event is scheduled as often as you specify in 
this field.

For for recurring events, this specifies how long the event is to be scheduled from 
the start time that you entered in the "Date" and "Time" fields.    If you don't 
specify a number, some default duration is assigned, depending on how often 
the event is to occur:
if the event occurs every         it will be scheduled for  
minute an hour
hour a day
day a week
week a month
month a year
year ever



Settings Program Command

The Settings|Program command displays a dialog to change configurable program 
parameters.
The First weekday radio buttons let you choose whether to display Monday or Sunday first 
in certain views.    (Currently, only the Day Selector tool honors this choice.)
The Week view radio buttons allow you to select between a 2-column and a 3-column 
layout for the Week View.
The Hour display radio buttons let you display hours in 24-hour or 12-hour format (eg. 
13:30 vs. 1:30pm).
You can enable and disable the Toolbar and Status bar with the Decorations check boxes.



Settings Calendar Command

The Settings|Calendar command displays a dialog to change calendar settings. 



Settings Fonts Command

The Settings|Fonts command displays a dialog to change fonts used in the UZPronto views.    





The Toolbar
The Toolbar is a row of buttons at the top of the main window which represent application commands. 
When the cursor is over one of these buttons, the Statusbar at the bottom of the main window will 
indicate what the button does.    Clicking one of the buttons is a quick alternative to choosing a 
command from the menu.    Buttons on the toolbar activate and deactivate according to the state of the 
application.

Button Action Menu Equivalent

Exit the application. File|Exit

Save the calendar File|Save

Print the calendar File|Print

Undo the last change Edit|Undo

Cut the selected appointment Edit|Cut

Copy the selected appointment Edit|Copy

Paste an appointment Edit|Paste
Display current day's appointments View|Day
Display current week's appointments View|Week
Display current month's appointments View|Month
Display previous page View|Previous
Display next page View|Next
Display today View|Today
Popup/dismiss Day Selector View|Day Selector
Popup Appointment Editor View|Appointment Editor

Display help file contents Help|Contents



Windows Keys
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Page Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






